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Abstract. 
The quality of education is very much influenced by factors, where one of the factors that affect the quality of education 
is the quality of learning in schools and can be seen from the increase in grades. Utilization of media in the learning 
process in the classroom to make the learning atmosphere fun and can increase student grades. The use of learning 
media to write rhymes can increase the learning motivation of 7th graders of Berastagi Private Middle School students. 
It can be seen from the results of simple linear regression testing that the t test significance value is 0.071 less than 0.1 
and the t regression coefficient is positive, meaning that the more frequent use of interactive learning media, the 

students' learning motivation will increase. There is a significant difference in value between before the use of 
interactive learning media and after the use of interactive power point learning media. It can be seen from the test 
results that the average paired sample difference produces a sig value of 0.000 less than 0.05. The value after using 
interactive learning media is higher than the value before using interactive power point learning media. Suggestions for 
further research to add other variables that affect students' learning motivation, because the results of this study 
indicate that the contribution of learning media to increasing students' learning motivation is only 3.8 percent. 
Suggestions for teachers to use interactive learning media as a means to deliver material to students, because it is 
proven that the use of interactive learning media can increase student values and motivation in learning. 
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I.  INTRODUCTION 

Technology that is so sophisticated and modern is able to penetrate the line of life, including in the 

implementation of education. Many people believe, with technology, everything will be easy, effective, 

practical and fast. The use of technology in education is an alternative to improve the quality and quantity 

where the results and processes include: learning resources, where teachers and students are required to 

actively use educational technology in the learning process.Educational objectives that have been stated in 

the National Education System Law will be achieved if the quality of education in Indonesia is good. But in 

reality, the quality of our education is still lagging behind other countries, especially ASEAN countries. In 

2017 the education index in the annual report issued by the United Nations Development Program Indonesia 

had an education index of 0.694 [1]. Based on these data, Indonesia is ranked sixth under Singapore, Brunei 

Darussalam, Malaysia, Thailand and the Philippines. In order to teach this backwardness, all elements in the 

field of education should work together to improve the quality of education in Indonesia.Therefore, the 

quality of education in Indonesia is one of the things that must be done to catch up. In the world of 

education, there are many things that can affect the quality of an education [2]. Students who have good 

learning achievements, must go through a quality learning process and have very good quality. Learning 

achievement is a picture of student success in the teaching and learning process based on the provisions that 

have been made by educators [3]. 

There are 2 factors that influence the learning achievement process, namely factors that come from 

within students called internal factors and factors that come from outside students or called external factors 

[4]. Learning motivation can be achieved if the learning process in the classroom is fun and able to arouse 

students' learning enthusiasm according to Slavin, the implementation of the teaching and learning process 

teachers must have the ability to create learning conditions that are fun, not tense, and a comfortable 

atmosphere in learning [5]. So that it can foster student learning motivation. It is the teacher's obligation to 

make the learning atmosphere in the classroom more interesting and the spirit of learning grows and can 

stimulate the growth of learning motivation. Based on the observations made there are still many problems in 

the learning process. For example, learning runs in one direction only from the teacher to students, the 
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method used is mostly lectures so that the learning atmosphere becomes bored, the teacher's unpreparedness 

in learning materials, preparation in teaching is lacking, the selection of learning media is monotonous and 

not varied, students' learning motivation is low, students less attention.One of the solutions to solve these 

problems is by utilizing the media in the learning process in the classroom to make the learning atmosphere 

fun and can stimulate the growth of students' motivation to write pantun. With the growth of students' 

learning motivation, the desire to learn to write rhymes will increase and learning achievement will be 

achieved.  

The use of media in rhyme writing material will stimulate the use of both senses, namely the senses 

of sight and hearing simultaneously so that they are able to absorb good subject matter.The Competency 

Standards for writing rhymes in the Indonesian language syllabus for class VII SMP contain, "Expressing 

thoughts, feelings and experiences through writing rhymes, while the basic competence is "Writing pantuns 

in accordance with the requirements of rhymes. "Through the Competency Standards and basic competencies 

above, there is a learning objective to write rhymes, namely students are able to write rhymes in accordance 

with the requirements of rhymes.The importance of the role of rhymes for various purposes, writing rhymes 

should be trained and assigned to students at school. Writing rhymes encourages students to produce literary 

works. Literary works are a place to apply the ideas of the author in the form of language expressions that 

validate both orally and in writing. In literary works there are various types of criticism, suggestions, advice 

and valuable knowledge from the author himself. So that literary works are able to play an active role in the 

maturation of a society continuously by following the movements or events that occur in people's lives.Based 

on the initial observations made by the researcher, it can be seen that students have difficulty starting to 

make rhymes. Some of the students spent a lot of time trying to start making rhymes. Some start from the 

sampiran, some start from the content of the rhyme. The motivation of students to write rhymes is also very 

low. Some students look desperate and then write down the poems that are in the book or that are 

remembered with a slight change.  

There are even students who only write rhymes in books [6].Learning to write rhymes is still not 

fully understood by students due to learning that is sometimes boring and teachers do not use media. So that 

students have difficulty in writing a good rhyme. To improve rhyme writing skills, teachers must be good at 

choosing interesting learning media. Learning materials packaged in teaching media can write children 

learning while playing and learning. Learning to write in the classroom requires tools or media that can help 

students optimize their writing skills. Interesting learning media such as pictures, graphics, videos or objects 

that attract attention will help the process of learning to write rhymes. One of the media that can provide 

interesting things for students is to be able to use power point media so that students feel that the learning 

taught by the teacher is interesting and efficient. Interactive Power Point is a software-based learning media 

on a computer. This is to make it easier to carry out the process of learning activities and make it easier for 

students to understand the content and intent of the learning. 

The most frequently used information technology in the field of education include: 

 Computers can combine animation, video and audio, as well as text and graphics simultaneously, and 

have the ability to interact so that the teaching and learning process is more interesting and quickly digested 

by students. 

 Computers allow the teacher to present and provide material to students in an interesting way, making 

teaching easier 

 Education can also be done at home. 

 Various educational institutions can implement distance learning. 

There are several principles that must be considered in the selection of learning media, including: 

a. The selection of learning media must be in accordance with the objectives to be achieved 

b. The selection of learning media must be with a clear concept 

c. The selection of learning media must be in accordance with the characteristics of students 

d. The selection of learning media must be in accordance with the student's learning style and the 

ability of the teacher 
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e. The selection of learning media must be in accordance with environmental conditions, facilities and 

time available for learning needs. 

This research has advantages because it uses interactive power point learning media which was made 

by the researcher himself, can present texts of learning materials, exercises, tests and images that can move 

or are interactive and can provide motivation to learn to write rhymes. Similar research was carried out 

Sugama, that with the application of interactive power point learning media, it was seen that learning 

motivation increased, because it used interactive learning media [7]. For the limited material, namely writing 

rhymes in accordance with the requirements of the rhyme.The study was conducted in class VII and its 

location is at the Private Middle School in Berastagi, Karo Regency, North Sumatra. In connection with the 

above, the researchers are interested in conducting research on "The Effectiveness of Using Interactive 

Power Point Learning Media on Motivation for Learning to Write Pantun Students for Class VII SMP 

Private Masehi Berastagi 2021/2022. 

Problem Identification  

1. The existence of the learning process at the school is still using the lecture method (conventional) 

2. The use of interactive Power Point-based rhyme learning media has not been implemented yet 

3. Very low student learning motivation 

4. At least the sources used are only teacher explanations and a few 

5. handbooks 

6. The lack of teachers using learning media that is arousing students' motivation in learning material 

for writing rhymes 

7. The use of media is still very limited and lack of variety 

Problem Limitation 

The scope of the effectiveness of learning rhymes in grade VII students of SMP Private Masehi 

Berastagi are: 

1. In accordance with the Basic Competence, namely writing rhymes in accordance with the 

requirements of the rhyme: explanation of the rhyme, the role of the rhyme, the structure of the 

rhyme, the characteristics of the rhyme, the types of rhyme. 

2. From this explanation, the researcher limits the material that is the scope of discussion in this study, 

namely "Writing Pantun" 

3. Through this study, there is a comparison of students' learning motivation using interactive power 

point learning media with students who have not used interactive power point learning media. 

4. Needs analysis in this study is the seventh grade students of the Private Masehi Junior High School 

Berastagi 

5. The research methodology uses regression analysis and the average difference test 

Problem Formulation 

1. Does the use of interactive learning media have a positive effect on students' learning motivation? 

2. Is there a significant difference in student scores between before using interactive learning media and 

after using interactive learning media? 

Research Objectives 

The objectives to be achieved for the effectiveness of this learning media are: 

1. Knowing the effect of interactive learning media on students' learning motivation 

2. Knowing the effectiveness of using interactive learning media through increasing student scores 

Benefits Of Research 

The things disclosed in this research are expected to provide theoretical and practical benefits. The 

theoretical benefits are as follows: 

1. As input for schools, Indonesian language teachers and students to take advantage of the availability 

of learning media in schools in order to increase learning motivation in learning to write pantun. 

2. As input and support for similar research in the effort to develop further research. 

3. Can be useful in the development of knowledge about the effectiveness of the use of learning media 

in relation to student learning outcomes. 
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While the practical benefits of this research are: 

1. For Writers 

To train and develop abilities in the field of research, as well as to increase the author's insight and 

knowledge about the effectiveness of learning media to write rhymes on the motivation of seventh 

grade students' learning outcomes. 

2. For Teachers 

As input for teachers about the effectiveness of using appropriate learning media in the teaching and 

learning process, so that it can generate student motivation in learning to write pantun. 

 

II.  THEORETICAL FOUNDATION 

Effectiveness 

The word effective comes from English, namely effective which means successful or something that 

is done successfully. Popular scientific dictionaries define effectiveness as the appropriateness of use, use or 

support for goals. The definition of effectiveness in general shows how far the achievement of a 

predetermined goal. The word effectiveness refers more to the targeted output. Effectiveness is a very 

important factor in the lesson because it determines the success rate of a learning media used. 

According to Mahmudi, effectiveness is the extent to which the units issued are able to achieve the 

goals set [8]. According to Nana Sudjana, effectiveness can be interpreted as an act of student success to 

achieve certain goals that can bring maximum learning outcomes [9]. The effectiveness of learning is clearly 

related to the efforts of the learning media used so that it can increase students' learning motivation. The 

effectiveness of learning according to Supriyono, refers to the power and effectiveness of all learning 

components that are organized to achieve learning objectives [10]. Effective learning includes all learning 

objectives, both mental, physical and social dimensions. Effective learning makes it easier for students to 

learn something useful. 

Instructional Media 

Learning media is used as a tool in education which is divided into several classifications according 

to function, type and source. The following is a theory regarding the understanding of learning media and the 

classification of learning media. Learning is an activity that involves a person, two or more parties, the most 

important thing is that the learning process occurs in it. In the learning process in a formal environment at 

school, the teacher strives for students to acquire knowledge, skills and positive values. 

According to Arsyad, "The development of science and technology increasingly encourages reform 

efforts in the use of technological results in the learning process" [11]. Teachers are required to be able to use 

the tools that can be provided by the school and it is possible that these tools are in accordance with the 

developments and demands of the times. For example, the availability of projectors, laptops and computer 

labs at schools. Teachers can take advantage of learning media that can be used as an effort to improve the 

quality of the process and student learning outcomes. 

Characteristics Of Learning Media 

The function of the media in the teaching and learning process according to Nana Sudjana in the 

journal Hasrul [12], namely: 

1. The use of media in the teaching and learning process is not an additional function, but has its own 

function as a tool to create an effective teaching and learning situation 

2. The use of instructional media is an integral part of the overall teaching situation. This means that 

teaching media is one of the elements developed by an educator 

3. The use of learning media is prioritized to accelerate the teaching and learning process and assist 

students in capturing the material provided by the educator . 

Nana Sudjana, in the journal Hasrul, said that learning media also have functions and roles as 

described below: 

1. Capture an object or certain events 

2. Manipulating certain circumstances, events or objects. 

3. Increase students' enthusiasm and motivation to learn [13,14] 

1483 

https://ijersc.org/


International Journal of Educational Research & Social Sciences                                                                      ISSN: 2774-5406 

 

https://ijersc.org 
 

There are three characteristics of the media used in learning activities according to Gerlach & Ely in 

journal Hosnan, [15] as follows: 

1. Fixative Property (Fixative Characteristics), this feature describes the ability of recording media, 

storing, preserving and reconstructing an event or object. Such as photography, video tapes, audio 

tapes, computer diskettes and films. 

2. Distributive property, allows an object or event to be transported through space and simultaneously 

presented to students with relatively the same stimulus experience regarding the event. 

3. Manipulative Property (Manipulative Characteristics), events that take two or three minutes.  

With the time-lapse recording technique, an event can be accelerated or slowed down when replaying the 

video recording. The ability of the media from manipulatives requires serious attention because if there is an 

error in rearranging the sequence of events or cutting the wrong part, there will also be misinterpretation 

which of course will be confusing and even misleading. 

Power Point 

PPT or power point which is an application that is widely used by people to present teaching 

materials or reports, works or their status [16]. While according to Daryanto, Microsoft Power Point is a 

software created and developed by the Microsoft company [17]. On the computer, these programs are usually 

grouped in Microsoft Office programs. The program is specially designed to deliver presentations, whether 

organized by companies, governments, education or individuals, with various menu features that can make it 

an attractive communication medium.Microsoft power point or PPT is a software used to compose an 

effective, professional, and easy presentation. Microsoft PPT will make an idea, idea or material more 

interesting and easy to understand [18].  

Meanwhile, Microsoft PPT 2016 comes with a number of new features. Some of the new features 

are a result of the development of previous existing features and some are completely new features. This 

combination produces Microsoft PPT 2016 applications that are more perfect, efficient, and can meet various 

needs [19].From the opinions of various experts, namely Azhar Arsyad, Daryanto, M. Syamsul Hadi, and 

Oscar Yulius, it was elaborated so that it can be concluded that PPT is software created and developed by 

Microsoft companies, on computers and usually these programs have been grouped in Microsoft Office 

programs and are used for compose an effective, professional and easy presentation. In addition, Microsoft 

PPT will make ideas, ideas and materials more interesting, clear and easy to understand by using various new 

features. 

 

III.  METHODS 

Microsoft Ppt 2016 Display 

The following are various views contained in Microsoft PPT 2016 and their functions. The initial 

view when opening the PPT can be seen in the following image: 

                
Fig 2.2. Microsoft PowerPoint 2016 preview and worksheet 

1484 

https://ijersc.org/


International Journal of Educational Research & Social Sciences                                                                                 ISSN: 2774-5406 
 

https://ijersc.org/ 

The functions in Microsoft PPT are as follows: 

1. Quick Access Toolbar 

 
Fig 2.3. Quick Access Toolbar Display 

 

The Quick Access Toolbar contains shortcuts for the Save, Undo, Repeat, and Start from Beginning 

functions 

2. File menu 

 

 

 

 

 

 

 

 

 

 

 

Fig 2.4. File Menu Display 

The File menu functions to create, open, save, print, and open files left over from previous work that 

the user has opened. 

3. Ribbon Tab Home 

 
Fig 2.5. Display of the Home Tab Ribbon 

Ribbon Tab Home has a variety of tools, their respective functions are: Clipboard, Slides, Fonts, 

Paragraphs, Drawing, Editing. This group of tools works: 

a. Clipboard, lets you use the copy, paste, cut, and format painter buttons 

b. Slide, in which there are add slide, layout, reset and delete buttons. 

c. Paragraph, in it there are buttons to adjust the alignment, bullet and numbering, line spacing, and 

several buttons to adjust paragraphs. 

d. Font, serves for formatting around letters. 

e. Drawing, in which there are Text box buttons, Austoshape, Arrange, Quick Styles, Shape Fill, 

Shape Outline, and Shape Effects. 

f. Editing, which consists of Find, Replace, and Select buttons. 

4. Ribbon Tab Insert 

 
Fig 2.6. Display of the Insert Tab Ribbon 

Ribbon Insert tab aims to insert an object in the presentation slide. The Insert tab consists of several 

tool groups, including: 

a. Tables, commands to add tables to your slide show. 

b. Images, to include images, clip art, screenshots and photo albums 

c. Illustrations, in which there are buttons that you can use to insert images, clipart, photo albums, shapes, 

smartart, and charts. 
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d. Links, includes buttons that can be used to create links on slides 

e. Text, enter text boxes, headers and footers, WordArt, Date and Time, Slide numbering, and objects from 

outside the application 

f.   Symbol, enter symbols and write formulas 

g. Media Clips, to add a sound file (sound) or movie (movie) in a slide 

5. Ribbon Tab Design 

 
Fig 2.7. Display of the Ribbon Tab Design 

Ribbon Design tab, related to the design of the slides in the presentation. The Design tab consists of 

several tool groups, including Page Setup, Themes, and Background, which are used to design slides. Here is 

the explanation. 

a. Page Setup, in which there are buttons to set the model of the slide, the size of the slide and 

whether the model is portrait or landscape 

b. Themes, related to the theme design that has been prepared by Ms. PowerPoint 2016. 

c. Background, to set the background so that the slide looks more lively and beautiful, we can also 

adjust, insert the background independently here. 

6. Ribbon Tab Transitions 

 
Fig 2.8. Display of the Tab Transitions Ri Ribbon 

The transition tab ribbon deals with slide motion options that include preview, Transition to this slide, 

and Timing. 

a. Preview, in this section we can see the slide show when it is run 

b. Transition to this Slide, The current slide transition. 

c. Timing, setting the timing of the motion of the slide, whether automatically or by clicking the 

mouse. 

7. Ribbon Tab Animations 

 
Fig 2.9. Display of the Ribbon Tab Animations 

On the Ribbon Tab Animations set the animation in the presentation. Through this tab you can add 

various types of animation to your slides. 

There are 4 tool groups that you can use, including: 

a. Preview, this button is also known as a preview or a temporary view of the results of the 

animation that you provide for your slides. 

b. Animations, you can choose animations for objects on the slide, consisting of animate and custom 

animations. 

c. Advanced animation, additional animation further 

d. Timing, to set the slide duration and sequence. 

8. Ribbon Tab Slide Show 

 
Fig 2.10. Display Ribbon Tab Slide Show 
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Ribbon Slide Show tab manages how slides are displayed in the presentation, including for example 

which slide will be displayed first. The Slide Show menu consists of several tool groups, including: 

a. Start Slide Show, to determine where your slides are run from, whether from the beginning (from 

beginning) or from the current slide (from current slide show) or of your own choice (custom 

slide show). 

b. Set Up, in this tool group there are buttons that can be used to hide slides (hide slides), record 

narration (record narration) and determine the order of slides (rehearse timings) to be displayed. 

c. Monitors, you can set the resolution of your presentation slides in this tool group. 

9. Ribbon Tab Review 

 
Fig 2.11. Display of the Review Tab Ribbon 

As the name implies, Review is used to review presentation slides before being saved, printed or 

presented. There are three tool groups on the Review Tab Ribbon, including: Proofing, which is used to 

check the writing that you make on the slide. Language, Comments, you can provide notes on the slides that 

you create and Compare, for setting comments. 

10. Ribbon Tab View 

 
Fig 2.12. Display Ribbon Tab View 

The View menu deals with slide show options whether in normal mode or if you choose something 

else. The tool groups found on the Ribbon Tab include: 

a. Presentation Views, in this section we can see the entirety of the slides that have been created. We 

can see it normally, slide sorter, notes page, and slide show, besides that we can also create slide 

masters. 

b. Show/Hide, to assist in making presentation slides, we can display rulers and gridlines. 

c. Zoom, can enlarge the size of the slide created or normally. 

d. Color/Grayscale, In this section we can determine whether the slides you create are colored 

(color) or black and white (grayscale). 

e. Window, we can manage the appearance of the PowerPoint window whether cascade, split, or 

move to another window. 

Motivation To Learn 

There are three motivational frameworks that have been developed by psychologists, namely: 

behaviorism, cognitive psychology, and humanism [20]. Experts who adhere to the notion of bahavior say 

that motivation starts from situations, conditions and objects that are fun. If this gives continuous satisfaction 

it will lead to behavior that is ready to do something. Cognitiveists say that what influences individual 

behavior is the thought process, because cognitiveists focus on how individuals process information and 

provide interpretations for specific situations. Humanists say that humans act in environmental situations and 

make choices about what to do, but they are more concerned with the general path of a person's 

development, the activity of one's potential and eliminating the obstacles to one's growth.From Koeswara 

said that in the discipline of psychology, motivation is a concept used to explain the forces that exist and 

work on the organism or individual that is the driving and directing of the individual's behavior. Motivational 

theorists in formulating a theoretical conception of motivation can be categorized into three main 

approaches, namely (1) a biological approach, (2) a behavioristic approach, and (3) a cognitive approach 
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[21]. Motivation is a construct and activation of behavior, while a more specific component of motivation 

related to certain types of behavior is called a motive. Motive is a driving factor that causes certain behavior, 

while motivation is the structure of various motives that arise in a person [22]. Then Smith and Sarason 

provide an understanding of motivation comes from the Latin word move which means encouragement or 

move, thus motivation is defined as the moving power from within a person to carry out activities in order to 

achieve a goal [23]. 

In line with the above, Terry and Franklin explain that within the individual that moves individuals to 

take action to achieve certain goals [24], McDonald in Soemanto states that motivation is a change of energy 

within a person's personality which is characterized by effective encouragement and reaction reactions in an 

effort to achieve goals. Achieving Goals In this formulation, it can be seen that there are three important 

elements, namely: (1) that motivation initiates energy changes in every human being. The development of 

motivation will bring some changes in the neurophysiological system that exists in the human organism, and 

its appearance will involve human physical activities, (2) motivation is characterized by the emergence of 

feelings, effects and emotions that can determine human behavior, (3) motivation is characterized by goal 

reactions [25]. So motivation in this case is actually a response to an action, namely a goal. Motivation does 

arise from within humans, but its emergence will be stimulated or driven by the existence of other elements 

in this case is the goal.Motivation is the urge to behave and act in a distinctive way caused by a hidden 

power within a person [26]. In connection with the above, Maslow argues that these forces involve the 

fulfillment of a set of needs that are classified according to the driving forces of five groups, namely: (1) 

physiological needs, namely the need to maintain life or basic human needs such as clothing, food and 

shelter.  

(2) the need for security, (3) the need for relatives (social) which includes the need to feel accepted or 

recognized, (4) the need for esteem, and (5) the need for self-actualization (development) [27]. Furthermore, 

this difference in levels of needs distinguishes human motives, ranging from biological needs that are innate 

from birth to complex psychological needs. A motive will control a person's behavior if the motive under it 

has been fulfilled. Human behavior is controlled at first with the lowest motives, namely physiological 

motives such as hunger motives, thirst motives and so on. Only after these motives are fulfilled the needs of 

the above motives begin to dominate. And so on until the highest motive is the self-actualization 

motive.Motivation that works in individuals has different strengths, there are motives that are so strong that 

they dominate other motives. The strongest motive is the motive that is the main cause of individual 

behavior. Weak motives let alone very weak ones. Handoko revealed that to find out the strength of the 

motives that are controlling a person in general, it can be seen through: (1) the strength of the will to act; (2) 

the amount of time provided; (3) willingness to leave the task; (4) willingness to pay for the action; (5) 

perseverance in carrying out tasks and others [28]. From some of the views above regarding motivation, it 

can be concluded that motivation is a change in energy within a person's self which is characterized by 

encouragement and reactions to efforts to achieve goals in meeting their needs. 

Write Pantun 

Pantun is Malay pantun that is rooted and entrenched in society [29]. Pantun is known by many 

names in various languages in the archipelago, watch (Tagalog), tuntun (Javanese), pantun (Tobanese) which 

have more or less the same meaning, namely an orderly speech, educating directions, form/politeness. 

Pantun spread almost all over Indonesia. The function of rhymes in all regions (Malay, Sundanese, 

Javanese), or other regions is the same, namely to educate and entertain. Through rhymes we entertain 

people by playing language sounds, insinuating (reprimanding that something is not good) indirectly or 

giving advice.This does not mean that our people are not assertive when they want to say something, but it 

can be said that we have our own style of expressing something. Through our ancestral rhymes we seem 

more polite to reprimand or advise people indirectly so that the people we are addressing do not feel 

embarrassed or cornered. Pantun is an old poem which is well known as paparikan, and in Javanese it is 

known as parikan [30]. Umry and Winarti also said that rhymes were classified as original forms of old 

pantun as well as mantras [31].  
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Pantun is also found in several regional literatures in Indonesia such as "parikan" in Javanese 

literature or "paparikan" in Sundanese literature. Sumardjo, explains that the pantun (traditional pantun) is a 

form originated from Indonesia [32]. It is an oral folklore in form of “folk pantun” [33]. Pantun is very 

popular in the language of Indonesia archipelago. In Javanese language it is known is parikan, and in 

Sundanese language is known as Paparikan. Daillie suggest that it is interesting to study pantun as an 

expression of thought and feelings (Interesting translation for studying rhymes as an expression of thoughts 

and rhymes as an expression of thoughts and feelings) [34].Meanwhile, according to Sigrid Spangenberg, 

translation of the Pantun can be found in many everyday situations in Malay life, both formal and informal 

[35]. It has diverse functions, varying from entertainment and storytelling to the formalization of a marriage 

proposal and other social situations. Akmal, said that among the Malay community, rhymes since hundreds 

of years ago have had a distinctive place as part of communication materials. Many things that cannot be 

stated in simple sentences can be replaced by the delivery of rhymes. The use of language as a means of 

communication, feels more flexible by including rhymes as part of it. Both in conversation, and in delivering 

remarks at various events. 

Characteristics Of Pantun 

Pantun has different characteristics from other literary works. The characteristics of the rhyme, 

among others: (a) each stanza consists of four lines or lines, (b) each syllable of each line is the same or 

almost the same (usually consists of four or more lines). almost the same (usually consisting of eight to 

twelve syllables), (c) rhythmic (rhymed) ab-ab or aa-aa, (d) the first and second lines are sampiran, which are 

usually unrelated (meaning and only taken only the rhyme is to say the meaning that will be issued, (e) the 

third and fourth lines are called the contents of the pantun, which is the purpose of the poem because the 

content of the poem contains a message that the singer really wants to convey [30]. The characteristics of the 

rhyme are five, namely (1) the rhyme consists of four lines in each stanza, (2) the first and second lines are 

called sampiran, (3) the third and fourth lines are the content of the meaning to be conveyed, (4) rhyming a-

b-a-b, and (5) the number of syllables in each stanza ranges from eight to twelve syllables [31]. Waridah 

suggests the characteristics of the rhyme as follows: 1) each stanza consists of four lines (lines), 2) each line 

consists of 8 to 12 syllables, 3) the final rhyme of each line a-b-a-b, 4) the first and second lines are 

sampiran, 5) the third and fourth lines are contents [37]. The Ministry of Education and Culture, explains that 

the characteristics of rhymes can be seen based on their shape.  

These characteristics cannot be changed. If changed, the rhyme will become a seloka, gurindam, or 

other old form of pantun. The characteristics of the rhyme are as follows: (1) Each stanza consists of four 

lines (lines), (2) Each line consists of 8 to 12 syllables, (3) The final rhyme of each line is a-b-a-b (4) The 

first and second lines are sampiran, (5) The third and fourth lines are the contents [29]. [32] Indrawati 

suggests the following characteristics of the rhyme: (1) Has stanzas and nisi, (2) Each stanza consists of four 

lines, (3) the number of syllables in each line is eight to twelve, (4) each stanza consists of two parts, namely 

sampiran and nisi, and (5) rhyming ab ab [38]. Zikri, et al explains that pantun is an old type of pantun, apart 

from gurindam, seloka and talibun, which rhymes a-b-a-b, there are four first and second lines which are 

sampiran and the second and fourth lines are content [39]. Hajar, added that the basic form of a rhyme 

containing four lines of rhyme can also be built between eight and twelve syllables, usually consisting of 

four or five. words, because Malay words are usually two-syllable in size [40]. Andriani, explains that 

pantun is a traditional Malay oral treasure consisting of four independent lines with an abab rhyme scheme. 

The first two lines are shadows or sampiran, while the next two lines contain content.Usually, the shadow 

part is the natural elements, while the content part refers to the human world which includes human feelings, 

thoughts and actions [41]. Wahyuni, explains that pantun is an old poem that has three characteristics. First, 

it consists of four lines in an ab-ab pattern. Second, each line consists of 8-12 syllables. Third, the first two 

lines as sampiran and the next two lines as contents. The word "rhyme" comes from the Minangkabau word 

"patun" which means guide. The characteristics of the rhyme basically consist of two elements of meaning 

and the element of validity is related to rhyme, stanzas, lines and syllables. 
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IV.  RESULT AND DISCUSSION  

Respondent Characteristics 

The characteristics of the respondents are the demographic characteristics of the research 

respondents. Characteristics of respondents can be seen in the following table. 

Table 4.1. Characteristics of Respondents 

Characteristics Repondents (%) 

Sex: 

Male 37 60.66 

Female 24 39.34 

Total 61 100.00 

Age: 

12 18 29.51 

13 37 60.66 

14 5 8.20 

15 1 1.64 

Total 61 100.00 

Classs: 

7.1 13 21.31 

7.2 15 24.59 

7.3 16 26.23 

7.4 8 13.11 

7.5 9 14.75 

Total 61 100.00 

Source: Research Data (processed) 

Respondents of this study were seventh grade students of Berastagi Private Middle School, Karo 

Regency, North Sumatra Province. The number of respondents was 61 students. Male respondents were 37 

students, and female respondents were 24 students. When viewed by age, respondents aged 12 years were 18 

students, 13 years old were 37 students, 14 years old were 5 students, and 15 years old were 1 student. 

Respondents are spread from grades 7.1 to 7.5. Respondents from class 7.1 are 13 students, class 7.2 is 15 

students, class 7.3 is 16 students, class 7.4 is 8 students, and class 7.5 is 9 students. 

Respondent Answer Score 

Table 4.2. Respondent's Answer Score 

Indicator Mean Maximum Minimum SD 

Use of Learning Media 

PMP1 2.79 4.00 1.00 0.86 

PMP2 2.69 4.00 1.00 0.89 

PMP4 2.74 4.00 1.00 0.77 

PMP6 2.74 4.00 1.00 0.96 

PMP8 2.75 4.00 1.00 0.89 

PMP9 2.67 4.00 1.00 0.93 

PMP13 2.80 4.00 1.00 0.93 

PMP15 2.90 4.00 1.00 0.75 

PMP17 2.72 4.00 1.00 0.84 

Motivation To Learn 

MB1 3.18 4.00 1.00 0.83 

MB2 3.02 4.00 1.00 0.67 

MB3 2.85 4.00 1.00 0.79 

MB5 3.00 4.00 1.00 0.86 

MB15 3.13 4.00 1.00 0.74 

MB16 2.75 4.00 1.00 0.87 

MB17 2.66 4.00 1.00 0.73 

MB18 3.30 4.00 1.00 0.78 

MB20 3.61 4.00 2.00 0.59 

MB29 3.59 4.00 1.00 0.74 
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Indicator Mean Maximum Minimum SD 

MB30 3.49 4.00 1.00 0.77 

MB31 3.49 4.00 1.00 0.74 

MB35 3.66 4.00 1.00 0.66 

MB36 3.56 4.00 1.00 0.76 

Source: Research Results (processed) 

Respondents' answer scores are only displayed on valid question items. Validity testing is presented 

in section 4.2.1. The score of respondents' answers using a Likert scale from 1-4, it can be seen that in Table 

4.2 the minimum value is 1 and the maximum is 4. The standard deviation shows that the respondents' 

answers are not too varied. 

Result Analysis and Interpretation 

Validity and Reliability Test Results 

Validity shows the extent to which a measuring instrument is able to measure what it wants to 

measure. To determine the level of validity, it is necessary to test the validity of the instrument. The results 

of the instrument validity test can be seen in the following table. 

Table 4.3. Results of the Variable Validity Test for the Use of Learning Media (Phase I) 

Indicator r-corrected* Description  

PMP1 .236 Invalid 

PMP2 .103 Invalid 

PMP3 .252 Valid 

PMP4 .473 Valid 

PMP5 .106 Invalid 

PMP6 .649 Valid 

PMP7 .170 Invalid 

PMP8 .301 Valid 

PMP9 .507 Valid 

PMP10 .253 Valid 

PMP11 .206 Invalid 

PMP12 -.162 Invalid 

PMP13 .379 Valid 

PMP14 .364 Valid 

PMP15 .348 Valid 

PMP16 .099 Invalid 

PMP17 .474 Valid 

PMP18 .253 Valid 

*Compared to table value=0.239 

Source: SPSS Output 

Table 4.4. Results of the Validity Test of Learning Motivation Variables (Phase I) 

Indicator r-corrected* Description  

MB1 .468 Valid 

MB2 .312 Valid 

MB3 .391 Valid 

MB4 .318 Valid 

MB5 .292 Valid 

MB6 .121 Invalid 

MB7 .477 Valid 

MB8 .036 Invalid 

MB9 -.243 Invalid 

MB10 -.338 Invalid 

MB11 .318 Valid 

MB12 .293 Valid 

MB13 -.191 Invalid 

MB14 -.249 Invalid 

MB15 -.085 Invalid 

MB16 .249 Valid 
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Indicator r-corrected* Description  

MB17 .196 Invalid 

MB18 .164 Invalid 

MB19 .237 Invalid 

MB20 .250 Valid 

MB21 .218 Invalid 

MB22 -.229 Invalid 

MB23 -.264 Invalid 

MB24 .211 Invalid 

MB25 -.060 Invalid 

MB26 .138 Invalid 

MB27 .124 Invalid 

MB28 .233 Invalid 

MB29 .374 Valid 

MB30 .182 Invalid 

MB31 .288 Valid 

MB32 -.448 Invalid 

MB33 .143 Invalid 

MB34 .097 Invalid 

MB35 .411 Valid 

MB36 .203 Invalid 

MB37 -.106 Invalid 

MB38 .090 Invalid 

MB39 -.150 Invalid 

MB40 .132 Invalid 

*Compared to table value=0.239 

Source: SPSS Output 

Valid both measuring the use of learning media and learning motivation. Then the re-validity test is 

carried out until all valid indicators are obtained. The results of the re-validity test can be seen in Table 4.5 

and Table 4.6. 

The Results of the Variable Validity Test for the Use of Learning Media  

(Phase II) 

Indicator r-corrected* Description  

PMP1 .517 Valid 

PMP2 .351 Valid 

PMP4 .438 Valid 

PMP6 .758 Valid 

PMP8 .602 Valid 

PMP9 .624 Valid 

PMP13 .574 Valid 

PMP15 .430 Valid 

PMP17 .628 Valid 

*Compared to table value=0.239 

Source: SPSS Output 

The Results of the Validity Test of Learning Motivation Variables (Phase II) 

Indicator r-corrected* Description  

MB1 .700 Valid 

MB2 .731 Valid 

MB3 .478 Valid 

MB5 .745 Valid 

MB15 .290 Valid 

MB16 .267 Valid 

MB17 .572 Valid 

MB18 .668 Valid 

MB20 .341 Valid 

MB29 .726 Valid 

MB30 .604 Valid 

MB31 .641 Valid 
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Indicator r-corrected* Description  

MB35 .752 Valid 

MB36 .654 Valid 

MB37 .422 Valid 

*Compared to table value=0.239 

Source: SPSS Output 

The results of the re-validity test are obtained that there are 9 (nine) valid indicators to measure the 

use of learning media, namely: PMP1, PMP2, PMP4, PMP6, PMP8, PMP9, PMP13, PMP15 and PMP17, 

and there are 15 (fifteen) valid indicators. to measure learning motivation, namely: MB1, MB2, MB3, MB5, 

MB15, MB16, MB17, MB18, MB20, MB29, MB30, MB31, MB35, MB36 and MB37. The right instrument 

is not only an instrument that is able to measure what it wants to measure, but also must be consistent if it is 

used to measure the same thing at different times. This shows that the instrument is reliable. The reliability 

results can be seen in the following table. 

Reliability Test Results 

Variabel Alpha-cronbach Description  

Use Of Learning Media 0,831 High reliability 

Motivation To Learn 0,897 High reliability 

Source: SPSS Output 

Both variables have an alpha-cronbach value greater than 0.8, meaning that the reliability of the 

measurement of the two variables is very high. 

Linear Regression Analysis 

Linear regression analysis was used to examine the effect of the effectiveness of using pantun 

learning media on students' learning motivation. The results of linear regression analysis can be seen in the 

following table. 

Linear Regression Results 

No. Variabel Koefisien t-stat Sig. 

1. Constant 40,007 8,433 0,00 

2. Use Of Learning Media 0,321 1,839 0,071 

F-stat 3,384 0,071 

R-square (adj) 3,8% 

Source: SPSS output 

*: Statistically significant (alpha = 5%) 

Based on the table above, if it is written in the regression equation, it is as follows: 

Motivation = 40,007+0,321*Learning Media 

The regression results in table 4.8 can be used to answer the first hypothesis, namely: 

  H1: The Use of Interactive Learning Media Has a Positive Effect on Learning Motivation 

In the simple linear regression equation, the value of the F test and t test will be the same because it 

only uses one independent variable. The results of the t and F tests obtained sig values. of 0.071 is less than 

0.1. So, it can be concluded that with a 90% confidence level, learning media has a positive effect on 

students' learning motivation. Each increase in the use of learning media by 1 unit, learning motivation will 

increase by 0.321 units.The coefficient of determination (adjusted R-square) is 3.8 percent. This can be 

interpreted that the contribution of learning media to increase students' learning motivation is 3.8 percent. In 

other words, changes that occur in learning motivation by 3.8 percent can be explained by the use of learning 

media, while the remaining 96.2 percent is explained by other variables not included in the study. Only very 

little contribution of learning media to increase students' motivation to learn. There are many other factors 

that influence student learning motivation that are not included in this study.To ensure that the results of the 

regression equation above are valid, it is necessary to test the classical assumption or OLS (Ordinary Least 

Square) which is required in multiple linear regression analysis. The classical assumption test is intended to 

ensure that the estimator in the regression equation formed is the best, linear, and unbiased estimator (Best 

Linear Unbiased Estimator). The classical assumption test is described as follows: 
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1. Assumption of Residual Normality 

To test the residual normality assumption, it can be seen through the P-P plot image as shown in 

Figure 4.1 below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 4.1. Normal P-P Plot 

The residual points spread along the diagonal line, so it can be concluded that the residuals are 

normally distributed. Thus, the assumption of residual normality is met. 

2. Heteroscedastic Assumption 

Heteroscedasticity is the residual variance between heterogeneous observation units. The regression 

equation requires that the residual variance must be homogeneous. To test the assumption of 

heteroscedasticity of residual variance, a plot between the residuals on the Y axis and the predicted value on 

the X axis is used. The results of the plot can be seen in Figure 4.6 below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 4.2. Plot between Residual and Predicted Value 

The plots between the residuals and the predicted value of the regression equation spread randomly, 

so it can be concluded that the assumption of homogeneity of the residual variance is met. 

3. Assumption of autocorrelation 

Autocorrelation is the residual between the units of interrelated observation. The regression equation 

requires no autocorrelation relationship. To test whether the autocorrelation assumption is violated or not, the 

Durbin-Watson test statistic is used. If the Durbin-Watson statistical value is between dU to 4-dU, then no 

autocorrelation is detected. The dL table value is 1.38, the dU table value is 1.45, and the resulting DW value 

of 1.868 is around 2, it can be concluded that no autocorrelation is detected, thus the autocorrelation 

assumption is fulfilled.All OLS assumptions are met, it can be concluded that the regression equation 

estimator above is best linear unbiased estimator, so the results of the valid regression equation are used to 

model the influence of learning media on learning motivation. 
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Paired Sample Mean Difference Test 

The paired sample mean difference test was used to see if there was a difference in value between 

before there was interactive learning media and after there was interactive learning media. Before the 

average difference test is carried out, a normality test is carried out first. The normality test is a prerequisite 

test before the average difference parametric test, if the normality condition is not met then the average 

difference test is carried out with a nonparametric approach with U-Mann Whitney. The results of the 

normality test can be seen in the table below. 

Table 4.9. Data Normality Test Results 

No. Variabel Sig. Description 

1 Value before 0,239 Normal distribution data 

2 Value after 0,109 Normal distribution data 

*Significant at 5% level 

Source: SPSS output (processed) 

Based on Table 4.9 above, all data groups are normally distributed, so the test of the average 

difference of paired samples uses a parametric approach. The results of the paired sample mean difference 

test using a parametric approach can be seen in the following table. 

Table 4.10. Paired Sample Test Results 

Couple Mean t-statistik Sig. 

Before after -4,213 -4,275 0.000 

*Significant at 5% level 

Source: SPSS output (processed) 

Based on Table 4.10 above, the sig. 0.000 is less than 0.05, it can be concluded that there is a 

significant difference between the scores before the interactive learning media and the scores after the 

interactive learning. The value before deducting after the average is -4.213, meaning that the value after is 

higher than the previous value. The results of this average difference test are used to answer the second 

hypothesis, namely: 

H2:  There Is a Significant Difference in Value Between Before the Use of Interactive Learning Media 

and After 

The results of this study indicate that there is a significant difference between the scores before the use 

of interactive learning media and after. The use of interactive learning media is proven to be effective in 

increasing student scores. 

 

V.  CONCLUSION  

The results of testing hypothesis 1 show that there is a positive influence on the use of interactive 

learning media with students' learning motivation. Previous research conducted by Yuliansyah et.al also 

showed that learning media was able to improve students' understanding, and increase students' courage in 

answering questions, so that the use of learning media was proven to be able to increase student motivation 

[43]. This study also shows the same thing that the use of learning media can increase the learning 

motivation of seventh grade students of Berastagi Private Middle School students.The results of testing 

hypothesis 2 show that there is a significant difference in value between before the use of interactive learning 

media and after the use of interactive learning media.  

So, it can be concluded that the use of interactive learning media can increase student scores. 

Previous research conducted by Kusuma, et al showed that the use of interactive learning media was more 

effective in improving student learning outcomes [44]. Research Salmiah et al, also shows that the use of 

interactive learning media is effective in increasing student learning mastery [45]. The results of this study 

also show the same thing that the use of interactive learning media can increase student scores. The results of 

this study as a whole indicate that the use of interactive learning media has proven to be effective because it 

can increase students' learning motivation while at the same time increasing students' grades. Suggestions for 

teachers to use interactive learning media as a means for delivering material to students to achieve mastery in 

student learning. 
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From the results of the research described in chapter IV, it can be concluded that: 

1. The use of learning media can increase the learning motivation of 7th grade students of Berastagi 

Private Middle School. It can be seen from the results of simple linear regression testing that the t-

test significance value of 0.071 is less than 0.1, and the regression coefficient is positive, meaning 

that the more frequent use of interactive learning media, the students' learning motivation will 

increase. 

2. There is a significant difference in value between before the use of interactive learning media and 

after the use of interactive learning media. This can be seen from the results of the test of the average 

difference of the paired samples resulting in a sig value of 0.000 less than 0.05. The score after using 

interactive learning media was higher than the score before using interactive learning media. 
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